What is on the Concise Chinese Materia Medica CD-ROM?

The Concise Chinese Materia Medica Application (CCMM Study) and the CCMM Self
Test software are an outcome of the learning strategy implemented in the Concise
Chinese Materia Medica text. By looking at how materia medica is taught in China, by
talking to teachers and listening to students who have learned materia medica for
examinations and clinical application, we found several significant factors:

1. The wide-spread simplification and summarization of medcinal indications and
actions makes memorization and clinical application more difficult because the
indications available to Chinese-speaking clinicians are not made clear, neither
the similarities nor the differences are sufficiently presented.

2. Differences in term use force students of materia medica to essentially guess
whether the clinical terms in different texts refer to the same idea. Trying to find
consensus by creating compilations of different texts is time-consuming and often
creates misinformation.

3. The significant memorization chores push students to create a variety of
memorization aids such as flash cards and self-tests.

The first problem has been addressed by the inclusion of all the concepts used in Chinese
descriptions in the Concise Chinese Materia Medica monographs and by explaining
those concepts prior to their first use. The second problem has been addressed by using
the large, published terminology of the Practical Dictionary of Chinese Medicine. The
concepts used by any materia medica or related text that provides a sufficient glossary
can be accurately referenced to the Concise Chinese Materia Medica. The last problem,
how to deal with the significant memorization chores involved in learning materia medica
is, perhaps not solved, but reduced by providing learning aids as part of a explicit
learning strategy. The CD accompanying the Concise Chinese Materia Medica
contains the effective self-test software developed by David Botton A.P. with question
sets for each of the chapters. These questions aid the memorization of often-tested data.
The CCMM Study Application helps readers by providing several convenient ways to
review the core materia medica.

A Cyber-Assisted Learning Plan for Materia Medica

Memorization by multiply re-reading reference monographs, or notes, doesn't work for
everyone. Because there is a genuine learning benefit to using multiple means of
memorization, students often create their own learning aids. This process of creation is
itself often a positive reinforcement for classroom lectures and readings. On the other
hand, the time consumed creating flash cards, self-tests and compiling information from
multiple books and lectures is very often more than can be comfortably fit into a student
time budget. Furthermore, rote memorization alone is not the most efficient way to
acquire knowledge.



The CCMM Study Application provides two services. First, it can be used in several
different ways to review the core data. For example, you might browse through the data
with one of the tabs (Actions, Dose, Contraindications, Biomedical, or Additional) active.
This will help you see the relationships between medicinals in a particular category.
Because of the multiple search capacity, and the ability to narrowly describe which aspect
of nomenclature is searched, you have a quick reference for whichever name or names
(English, Pinyin or Latin) you are memorizing. Students may also use the CCMM Study
application to review the core material before exams or as needed. Once in clinical
practice, the application provides fast access to doses, contraindications and other data.

Second, the notes facility allows you to permanently incorporate your teacher's notes, or
notes of your own, or notes developed with fellow students. These notes can be backed-
up using the export facility and become a permanent part of each person's database. The
idea is that instructors who use the Concise Chinese Materia Medica as their core text
will be able to create a set of notes that they can export and distribute for importation into
each student’s copy of the CCMM Study Application, therefore customizing their course.
Students may also cooperate in the development of notes to be shared. Keep in mind that
the export and import facilities are “all at once,” the entire notes database is exported, the
entire notes database is imported each time. If you work in a group, the first person must
complete their work and pass their export file to the next person, and so on. When
everyone's contribution has been included, the last person to update the notes can export
the final data set for all to import. Since you can use the CCMM Study application for a
quick reference during clinical practice, you can continue to add notes as you wish.

Paradigm Publications is experimenting with this approach as an answer to the legitimate
desire of readers to have information available in electronically-searchable form. It has
been tested on Windows XP and MacIntosh OSX. The software is not guaranteed in
any way, no charge for its use has been added to the price of the text. We will be pleased
to learn your opinions and suggestions, however, we cannot support these applications.
We hope it will be useful for your studies and reference but it neither contains the entire
content of the text, nor is there any information in the CCMM Study Application that is
not in Concise Chinese Materia Medica, except for the notes you may add. The CCMM
Study Application is not meant to be a general materia medica database. It is a study and
reference aid we have found useful, nothing less, nothing more. We do not guarantee,
offer or imply in any manner that the software will work on your computer, or that it will
accomplish any purpose to which you may wish to use it.

We created CCMM Study application in the process of producing the Concise Chinese
Materia Medica and found it useful as an easy reference and note book. While it
certainly does not serve every conceivable purpose, by keeping the software simple and
limited in scope, we are able to provide it to our readers for free. Put in the proverbial
nut shell, we made it for ourselves and our giving it to you with the hope that it serves a
beneficial purpose.



What is Green Software?

What software should be labeled “Green” is not well defined and the term “green” is used
to label applications as diverse as energy-monitoring and group collaboration web sites.
The CCMM Study Application is green in that it is not encumbered by proprietary
installers and routines that increase the utilization of computer resources, for example, to
monitor your use. We have made it easy for you to share your notes with others by
providing an exchange mechanism.

You install the CCMM Study Application by copying the appropriate contents (see
Intall.txt in each version directory) from the CD-ROM to your hard drive. It is launched
by double clicking the application. If you choose to create a desktop icon (on Windows)
or to keep the CCMM Study application in the dock (on OSX), follow the directions for
your operating system:

Windows: http://support.microsoft.com/kb/140443
Maclntosh: http://support.apple.com/kb/HT2474?viewlocale=en _US

The CCMM Application is bonus software that provides the core content of the Concise
Chinese Materia Medica you have purchased. The core information it presents is
copyrighted, your installation and use of the software is granted as an extension of your
right to use the CCMM text you have purchased. For example, an instructor who is
using the Concise Chinese Materia Medica in class can prepare sets of notes to be
imported into each student’s copy of the application. Thus, as they browse the core
information, their teacher’s comments can also be followed. In this case, the instructor’s
notes belong to the instructor and can be distributed, or not, according to their own
requirements. The core data, on the other hand, is taken from the text and cannot be
copied, imported or exported.

Student study groups can also share notes in this manner. Students typically try to find
consensus among different texts by making compilations of information taken from those
texts. The notes facility allows you to add this information using the built-in text editor
for the Notes field. This is not, however, a permission to violate the copyrights of others
by copying the content of their texts. Keep in mind that the data is itself a consensus
from Chinese didactic literature. It is also important to remember that many sources of
materia medica information do not precisely translate the clinical and therapeutic
concepts but use looser or summarized translations. Making comparisons thus requires a
certain amount of guesswork. The best way to be sure that two terms reference the same
idea is to be sure that the Chinese characters or the toned pinyin are the same.

Please keep in mind that when you import one set of notes, any prior notes will be
replaced.


http://support.microsoft.com/kb/140443
http://support.apple.com/kb/HT2474?viewlocale=en_US

Warning!

Once installed the application, the Medical Data file, and your system provide a whole.
If you remove one part of that whole, the application will be unable to run. Therefore,
you may not copy an application from one system to another. There is an import and
export procedure that allows you to create a file that may be used to import your notes to
another copy of the application. Keep in mind that the sharing is absolute, in other
words, loading your notes into another copy will replace any notes that have been added
to that copy. Because you have purchased the Concise Chinese Materia Medica you
may use the application on all of your own systems.

If the Application is fixed to my hard disk, how can I change computers
or back-up my notes?

1. Export your notes on the old computer and move the export file to your new
computer.

2. Use the CD-ROM to copy the application to your new computer.

3. Install the application on your new computer,

4. Import your notes.

If you wish to have a copy of the application on both your home computer and a lap top,
follow the same steps.

To backup your notes, simply export them and save the exported file in a safe place. Do
not lose your CD-ROM, it is you back-up.

Does the Application gather and report any information about me or
my computer?

No. The CCMM Study application records nothing and reports nothing about your use.

It uses an interior licensing method to keep the Medical Data and Application files
together. If they are separated, or if the Medical Data file is corrupted by outside
accesses, the system will fail. It would likely become out-of-sync and useless at any rate.

How was the content generated?

The Concise Chinese Materia Medica is neither a translation of a specific Chinese
language materia medica nor the authors’ personal assessment of Chinese materia
medica. The authors surveyed the Chinese medical teaching texts used in the People’s
Republic of China and recorded the core information that is consistent throughout that
literature. Thus, the content of the text, the medicinals presented and their clinical
qualities, are a meta study of what Chinese-speaking Chinese medical students are taught
in the P.R.C. Thus, the content represents a foundation knowledge for English-speaking
clinicians who are studying Chinese internal medicine.



This, of course, is not the entire scope of Chinese materia medica which covers some
thousands of medicinals. However, the 434 medicinals presented in the text and
application are a sub-set of the entire materia medica that includes those commonly used
in clinic, as well as medicinals taught for their didactic or historical value.

How to use the CCMM Study Application

Once you have loaded the appropriate CCMM Application folder to your hard drive,
double click the CCMM Study.executable (.exe on windows, .app on Maclntosh). The
application will then start. The windows version is shown in the following illustrations.
The Maclntosh version varies slightly as regards the screen-sizing controls and the
display of the icons. Maclntosh users will be familiar with these controls.
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The screen is divided into five major areas. The Header Area contains the icons for
operating the application and the Notes text editor.

The first section of the header presents general controls, as well as the File, Edit, and
Help menus.
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Fﬁ Clicking the “Import Icon” or using “Import” in the File Menus will open a dialog
box in which you can specify the name of the XML file to import into your notes. Please
remember, importing notes removes any notes you have not saved to an import file. You
may keep multiple notes files but only one can be imported at one time.

@ Clicking the “Export Icon” or using “Export” in the File Menu will open a dialog box
in which you can specify the name of the XML file in which to store your notes.

@ Clicking the Search Icon toggles the screen view from the default (show above) with
the search dialog and full screen mode:
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In both full screen and search mode you may resize the screen using the size boxes (upper
right on Windows or upper left on OSX) or by dragging one of the edges. As the size
changes the text will redisplay to fit the space available on your display.

The next section of the header controls the Notes Editor. The notes editor provides basic
text editing features so that you can format your notes as you wish.



g% The “cut” icon (or using “cut” in the Edit Menu), stores the highlighted text on the
clipboard and removes it from the Notes area. You can transfer your notes to and from a
word processor using the “cut” and “copy” tools.

._Ii The “copy” icon (or using “copy” in the Edit Menu), stores the highlighted text on
the clipboard but does not remove it from the Notes area. You can only transfer your
notes using the “cut” and “copy” tools.

[ | The “Paste” icon copies from the clipboard to the Notes area. You can paste text
you have copied from a different digital source into the notes area. For example, you can
enter notes you have stored in a word processor by copy and paste.

D The “Save” icon or using “Save” in the File Menu makes the changes you have made
to the Notes area permanent. Attempting to move to another medicinal display after
making changes will initiate a dialog box asking if you wish to save your changes. A
dialog box will also announce that the save has successfully updated the Medical Data
file.

F V¥ The “Font” icon will display the fonts available on your system. Choosing a font
will change highlighted test to that font, or begin use of that font at the insertion point.
You can enter Chinese; provided a Chinese font is available on your system. The
Information Display text is in Arial Unicode MS. This font displays both the Chinese
characters and the pinyin tones in an attractive and readable way. You may use any font
you wish for you notes.

TTV The “Font Size” icon will display a selection of appropriate font sizes. Choosing a
font size will change highlighted test to that font size, or begin use of that font at the
insertion point.

& V¥ The “Font Color” icon provides a selection of useful colors. Choosing a font color
will change highlighted test to that color, or begin use of that color at the insertion point.
We have seen shifting of the text colored on OSX systems. This may be dependent on
fonts. Use text coloring only if you find that it is not distracting.

B The “Bold” icon emboldens highlighted text or begins use of emboldened type at the
insertion point.

I The “Italic” icon italicizes highlighted text or begins use of italic type at the insertion
point.

u The “Underline” icon underlines highlighted text or begins use of underlined type at
the insertion point.



@ Using the “Quit” icon, or using “Quit” in the file menu quits the application.
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These icons move you through the database to the First, Next,

Pervious, and Last medicinals. The sequence number of the medicinal as found in the
Concise Chinese Materia Medica is also displayed.

The Search area of the application permits sophisticated search of medicinal names by

different criteria.
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Remember clicking on a
medicinal in the Search
Results will display that

medicinal.

The Input Keyword for Searching area allows
entering the text for which you wish to search.
Once those medicinals matching the entered criteria
are listed in the Search Result dialog, click the one
you wish to display.

The You want to search in . ... boxes allow for an
advanced search. You can choose to limit your
search to one or more of

English Name

Latin Name

Untoned Pinyin

Chinese Name

Alternative Chinese Name
Toned Pinyin

Section

The dialog box accepts Chinese characters and the
diacritical marks necessary for toned pinyin provided
these are available on your system.

The How do you want to match ... selection
toggles between a “Fuzzy Search” where close
matches will be displayed for your choosing in the
Search Result area or a “Precise Search” which
requires an every-detail-exact match. Fuzzy search
is the default and is appropriate for most of your
searching.

The Search Result area displays the English,
Chinese and Pinyin for the medicinals that match
your criteria, the size of each may be adjusted by
dragging the edges. The first match is also shown in
the Information area.



How to use “Fuzzy Search” and “Precise Search?”

Fuzzy search is ideal for finding items where you remember only part of the name.

However, it is also useful for comparisons. For example, search on either =, Shéng,
Ginger,or Sheng and you will get the same list of the medicinals that contain the

character ZE.
Information: Brief

This section provides core information about the medicinal directly from the Concise
Chinese Materia Medica:
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English Name: This is the name by which the medicinal is known in English.

Latin Name: This is the standard pharmaceutical latin for the medicinal.

Untoned Pinyin: Many English-language texts and articles on internal medicine do not
provide the tone marks necessary to distinguish a medicinal in all circumstances. As
well, some older systems do not have the fonts or input method necessary to use
diacritical marks. The Untoned Pinyin field has been included for searching where
diatcritical marks are not available.

Chinese Name: This is the P.R.C. standard for this medicinal.

Alternative Chinese Name: Some medicinals have alternate names derived from
historic or regional use. These are included here.

Toned Pinyin: This is the PRC standard for this medicinal.

Section: This is the section of the Concise Chinese Materia Medica in which this
medicinal appears.

Source (Latin Botanical): This is the scientific identification of the source substance for
this medicinal.



Image: We have made every attempt to color-match medicinals so that you get an
excellent idea of the actual color. Although the vast majority of the images were
obtained from a single Chinese pharmacy and photographed under the same conditions, it
was impossible to get every high quality example from any single pharmacy, Thus, it
was necessary to obtain samples not only in the P.R.C., but also the R.O.C, the U.S., and
in a very few cases from archive photographs. If you wish to have the best possible
color display, use a “color bar” image and adjust your monitor to display the colors
accurately. There is a color bar image here:

http://upload.wikimedia.org/wikipedia/commons/6/66/SMPTE_Color_Bars.sv

Ideally, the monitor image should be matched to a printed image. However, if the colors
are not “eyeball” distorted on your monitor, the images should be reasonably accurate.

Sample Image:
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There are five information sections each of which is selected by clicking on the
appropriate tab:

Actions: The Actions Tab displays all of the main actions presented in the Concise
Chinese Materia Medica monographs. This is an ideal way to review, prepare for
examinations, or to reference the qualities different medicinals.

Dose: This tab displays the dose range gram weight or other appropriate measure for the
medicinal. Where there are special considerations, these too are listed.


http://upload.wikimedia.org/wikipedia/commons/6/66/SMPTE_Color_Bars.svg

Contraindications: Where there are specific contraindications or cautions for the use of
a medicinal, they are listed under this tab.

Biomedical: In the Chinese material medica literature some medicinals are used for
specific biomedical diagnoses. These are listed under the “biomedical” tab when
applicable. A minority of medicinals have biomedical indications.

Additional: When a medicinal requires a note regarding its use, that note will appear
under this tab. Most medicinals in the Concise Chinese Materia Medica have not
required additional notes.

Notes:

This is a basic text editor for entering information about a medicinal. As described
earlier, this allows you to import your teacher’s notes or to develop a set of notes for your
self or for a study group.

. -

The text editor is functional but not sophisticated. It provides font, type size, style and
color controls. The core data is in Arial Unicode MS. This font displays both the
Chinese characters and the pinyin tones fully and attractively. Other fonts, if present on
your system, will also work. Simsun, which is generally available, does not display toned
pinyin particularly well. Keep in mind that the Notes will redisplay when you expand or
contract the application window.

We anticipate several ways to use the Notes facility:

1. Teacher to Students: A teacher produces a set of materia medica notes on their
copy of the CCMM Study Application. The exported copy of the Notes is
distributed to each member of the class, and imported. Each class member can
then annotate the class notes as they wish.

2. Student to Student: If one student wishes to pass their Notes to another student,
they need only export their Notes and provide the exported file to their friend.

3. Student Groups: Where a group of students wish to share the development of a
Note set, care must be used to avoid over-writing notes on import. The first
student should prepare their part of the Notes. Once complete, the first student
passes the exported Note file to the second student, who completes their share of
the work. This student-to-student passing continues until the entire Note set is



complete. It can then be exported and imported by all. Please do not attempt to
share the Medical Data file, the system will fail, and re-installing the system
will also fail.

Individual Notebook: Where only one person is using the application, changes
can be made ad hoc, backed-up and imported as necessary.

Notes for a Clinical Group: In a group practice several people may wish to make
ad hoc entries. This is possible so long as only one system (for example, one
computer in the clinic) is used and the notes from that computer are exported for
transfer to each clinician's system.



